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1.1 Objectives 

 Learn to set up and access the coordinate geometry database. 

 Become proficient in using Geopak Coordinate Geometry. 

1.2 Definitions 

Coordinate Geometry (COGO) is a method of using XYZ coordinates to store geometric 

elements such as points, lines, curves, spirals, chains, parcels, and profiles.  The Coordinate 

Geometry dialog box is an interactive graphical user interface for storing coordinate geometry 

elements. 

1.2.1 Coordinate System 

The coordinate system is defined with XYZ coordinates.  The X and Y coordinates define a 

horizontal plane, while the Z coordinate defines the vertical dimension.  All points in a cogo 

element are defined by at least an X coordinate and a Y coordinate.  If an elevation is to be 

stored, the Z coordinate will also be defined.   

 

 

The XYZ coordinates can also be referred to in Northing (N), Easting (E), and Elevation (Z) 

coordinates.  The Northing coordinate refers to the Y value, the Easting coordinate refers to the 

X value, and the Elevation refers to the Z value.   
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The user must be aware of the coordinate system the data is in, and the coordinate system that 

GEOPAK is using.  When referring to the XYZ coordinate system, the coordinates are listed as 

(X, Y, Z).   When referring to the Northing, Easting, Elevation coordinate system, the 

coordinates are listed as (N, E, Elev.).  When translating this to the XYZ coordinate system, the 

coordinates would be (Y, X, Z). 

1.2.2 Points 

Points are defined by a single set of coordinates.  Each point will have an X and a Y coordinate.  

The point may also have a Z coordinate if an elevation is defined.   

 

Point names are alpha-numeric.  If alphabetic characters are used, they must come before any 

numeric characters.  The point name must contain at least 1 numeric character at the end of the 

name.  Names can be up to 15 characters in length, although limiting the name to 8 characters is 

recommended. 

 

Points can be stored from a set of coordinates, or located from other elements.  To define a point 

from another point, a distance and direction need to be defined.   

 

 

Modifiers can be added to the direction and distance.  An offset can be applied.  This will locate 

the point at the specified distance and direction from the starting point, then perpendicular to the 

specified direction for the specified offset distance.  A positive offset will go to the right of the 

specified direction, and a negative offset will go to the left of the specified direction. 
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Distances and directions can also be found mathematically.  Values can be added, subtracted, 

multiplied, divided, or computed with a trigonometry function  

 

1.2.3 Lines and Line Segments 

Lines are defined by a location point and a direction, and are infinite in length.  Line Segments 

are a portion of a line that is defined by a beginning and an ending point.  Line Segment names 

can be alphanumeric up to 15 characters, but cannot be numeric-alpha. 

 

 

loc 115 trav 102 dis 107 to 108 m 20.50 n 40 18 33 w off 30 
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1.2.4 Curves 

Curves are a segment of a circular arc.  Curves can be defined by either the arc method (central 

angle that produces a 100’ arc) or chord definition (central angle that produces a 100’ chord).  

MoDOT uses the arc definition for all new alignments, however the chord definition has been 

used in the past, and may still be shown on old plans. 

 

A curve has several points associated with it.  These points help to define the curve, and are 

stored automatically when the curve is stored. 

 

PC – Point of Curvature; Beginning of the curve. 

PT – Point of Tangency; End of the curve. 

PI – Point of Intersection; Point where the two tangents meet. 

CC – Circle Center; Point at the center of the circle from which the curve is segmented. 

 

 

 

Curve names can be any alphanumeric characters up to 15 characters in length. 
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1.2.5 Spirals 

Spirals are a transitional curve.  Typically a spiral will transition from a tangent (infinite radius) 

to a specified radius defined by a curve.  Spirals can also transition between 2 specified radii as 

defined by 2 curves. 

 

Several points are also stored with a spiral.  They are as follows: 

 

TS – Tangent to Spiral Point 

SC – Spiral to Curve Point 

CS – Curve to Spiral Point 

ST – Spiral to Tangent Point 

PISCS – Overall Point of Intersection for the spiral-curve-spiral combination. 

 

 

1.2.6 Chains 

Chains are a combination of other elements.  They can consist of points, curves, spirals, or other 

chains.  Chains can represent horizontal alignments, or the horizontal location of some element.  

Chains have stationing associated with them.  Locations along the chain can be determined by 

the stationing.  If the stationing is adjusted along the chain a station equation is used.  The 

stations from the beginning of the chain to the first station equation are referred to as Region 1.  

The stations from the first station equation to the second station equation or the end of the 

chain are referred to as Region 2. 

 

 

Chain names can be any alpha-numeric characters up to a length of 15 characters. 
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1.2.7 Profiles 

Profiles are vertical alignments defined by stations and elevations.  They are generally 

associated with some horizontal chain.  Profiles can be stored with or without vertical curves.  

Profiles without curves generally represent the existing ground profile, or a ditch profile.  

Profiles with vertical curves are generally used as proposed alignment profiles. 

1.3 Accessing 

From Project Manager choose Coordinate Geometry, or choose the Coordinate 

Geometry icon.  

 

When Coordinate Geometry is started, the Start-Up 

Dialog Box appears.  

 

Project Name – shows name displayed on reports 

(optional entry, 60 alphanumeric characters max).  If 

Project Manager is used, this field will be filled in 

automatically. 

 

Job Number  - identifies coordinate geometry database (3 

alphanumeric characters, max) (required). If Project Manager is used, this field will be filled in 

automatically. 

 

Operator Code – identifies a unique 2-character operator code.  Allows multiple users access to 

database.  (Required, user’s initials suggested). If Project Manager is used, this field will be 

filled in automatically. 

 

Subject - description of work (48 alphanumeric characters, max) (optional) 

 

Once these parameters have been defined, the coordinate geometry dialog box will appear. 
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1.4 Coordinate Geometry Dialog Box 

 

The coordinate geometry dialog box is made up of three separate display areas: 

 

1) Tool Bar consisting of pull down menus and icons.  The icons displayed are 

customizable. 

 

2) Command Key-in allows commands to be typed in.  The drop down button 

allows for a history of commands to be seen. 

 

3) Output Window shows the results generated by the commands. 
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1.4.1 File Commands 

 
 

COGO Preferences 

 

 
 

Job Open Mode: (Create, No Create and Query) 

This determines the file creation constraints imposed on creating new coordinate geometry data 

files. Coordinate geometry data is stored into a file named job** .gpk where ** is the user-

specified job number for a given project. Each time the Coordinate Geometry window is invoked 

for a job number that does not correspond with a job**.gpk file in the current or specified 

working directory, GEOPAK creates a new job**.gpk file contingent on the constraints imposed 

by the Job Open Mode parameter. 

 Create - Automatically creates a new coordinate geometry database. 

 No Create - This mode does not permit creation of a new coordinate geometry database 

and provides a warning. 

 Query - With this mode, the user is queried when a job number is requested that does not 

correspond with a job**.gpk file in the current directory. Once queried, the designer may 

proceed with the database creation or cancel it. 

Directories: (Job Directory, Input File Directory, Output File Directory) 

Normally, input and output files are stored in the project directory, in which case, these fields 

would be blank. However, there are times when they are located in other directories, which can 

be keyed into these fields. In lieu of typing, pressing any of the Select buttons invokes the Select 

Directory Manager, wherein the desired directory may be specified. 
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Redefinition of Elements 

When the toggle is activated, existing elements in the Coordinate Geometry component can be 

redefined. For example, point number 8523 that was previously defined to coordinate values can 

be set to new coordinate values when this toggle is active. Otherwise, the Coordinate Geometry 

component would not store the new coordinate values with point number 8523 and a warning 

message "Element already exists" is displayed on the screen. This serves as a protection to the 

integrity of the coordinate geometry database. The Redefine toggle in the Coordinate Geometry 

window can achieve the same functionality. 

Force Redefinition Off at COGO Activation 

When this toggle is activated, and coordinate geometry is invoked, the Redefine button is not 

active, so that no redefinition of elements is permitted. However, at any time during the session, 

the Redefine toggle may be activated. 

Import File Utility – this tool is for manipulating input files.  When this tool is selected, the 

dialog with a list of available input files below appears.  File utilities include Load, Append, 

Catalog, Delete, Output, Print, and Save.  

 

 

Load - Highlight a file then click the 

Apply button. The input lines from 

the highlighted file are now 

displayed in the output buffer and 

are ready for modify, delete, edit or 

read. 

 

Append - A new input file is created 

by copying the contents of an 

existing input file to the end of the 

current input file; you must use the 

Save command to store this new file. 

 

Catalog - when selected, a menu 

appears listing all saved input files 

in the project directory.  This is for 

reference only no action is taken. 

 

Delete - when selected, a menu 

appears listing all saved input files. Highlight a file then click the OK button to remove this file 

from your project directory. 

 

Output - writes a Geopak output file from your current output buffer session to a newly created 

file for reviewing and printing. (Fname999.ooc) 
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Print Input File - sends your input file to the printer. 

 

Print Output File - sends your out file to the printer. 

 

Save - will save the current input buffer to a file. (Fname999.ioc) 

 

 

File Restore – converts an ASCII file of Geopak commands to a Geopak COGO input file. 

  

Import - will import horizontal and vertical alignments and points from RDS, SDMS, 

LandXML 1.0 Geometry, and Virginia Department of Transportation file format into the Geopak 

.gpk file. 

 

Export - will export Geopak, points, chains and profiles into into SDMS format and LandXML 

1.0 Geometry. 

 

Since most surveying software now reads LandXML format, it is recommended to extract 

geometry into this format for providing it to contractors. 

 

 

The Export option in GEOPAK for 

profile is only activated (visible on 

the dialog) when you are also 

exporting chains.  You cannot export 

just a profile by itself as LandXML 

does not permit this. 

 

 

 

 

Exit - closes the COGO dialog box 

and ends the coordinate geometry 

session. A prompt to save the session 

appears. Yes saves the input buffer, No exits without saving, Cancel returns to the COGO 

session. Whether you pick Yes or No everything you did is still saved in the .gpk file. 

 

 

Input File Restore  

 

An ASCII formatted file of GEOPAK commands can be converted to a regular GEOPAK input 

file by means of the Restore command. This ASCII file might be created manually via an editor 

or generated by the Store Graphics tool. 

 

 

 

 



GEOPAK Road Chapter 1 - Coordinate Geometry 

9/21/12 Missouri Department of Transportation 1-11 

Database Utilities 

 

Both tools perform utility functions on the specified GPK file.  The 

current Job is shown as the default. 

 

Validate  - Looks for problems and errors in the GPK database and 

reports findings. Does not attempt to clean or compress the database. 

Clean and Compress - This command scans the current GPK file and removes any corrupt 

element(s) as part of the rebuilding process.  It also compresses the GPK file.    The results of the 

rebuilding are contained within a log file in the same directory as the GPK file. 

Warning:  Be sure to back up your GPK file before utilizing this tool, as there is no undo!   

 

 

Import 

 

The File > Import tools supports importing data in a 

variety of set formats. 

 

 

Merge GPK File 

The Import or Merge GPK File tool merges the specified GPK file into the current GPK file.   

Type in the Job or click Select Job File.  

Click Merge to commence processing.   

 

ASCII Points 

 

This tool will directly store plain ASCII 

XYZ file, no Survey Chains will be created. 

 The ASCII file must have one line of data 

per point.  Enter the name of the file or click 

Select.  Then set the delimiter (character 

between each field in the data).  If a 

comment is in the file, it must be at the end 

of the line, and separated by a unique 

delimiter.  Set the None or Invalid Point 

Name and Chain name.  If the Duplicate 

Filter Tolerance is on, any point within the specified tolerance of another point is ignored.  The 

last step is the set the order of the fields within each row (Field Order).   If the first row is Point#, 

X, and Y, set the Field Order to Point#, East(X), North(Y), and the rest to None.  Click Apply to 

commence processing. 
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SDMS Alignments and Points 

Key in the name of the SDMS File or click 

Select.   

Three types of input are supported:  

 Horizontal Alignments,  

 Vertical Alignments, and  

 Points.  

Click Import to commence processing.  

 

Land XML 1.0 Geometry 

GEOPAK supports importing of XML type files. 

 Enter the name of the file or click Select.  Turn 

on elements to import:  Points, Chains or Profiles. 

 Note multiple elements toggled on are supported. 

 Click Import to commence processing. 

 

 

Export 

 

ASCII Points 

The dialog is divided into three 

main sections:  

 

The dialog is divided into three 

main sections:  

 Select Points to Export 

 Output Format  

 File and Replacement 

Options 
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File and Replacement Options 

Output File - Name of the output file to be created or appended. The file can be manually typed 

in, or selected by pressing the Files icon. 

File Create / File Append - Determines whether the file is created or appended. If set to File 

Create, and the file already exists, an Alert message is displayed, prompting whether the file 

should be overwritten.  

Replace “No Elevation” with - If the selected point has no elevation, the specified value is 

utilized. 

Replace "No Feature" with - If the selected point has no feature, the specified feature is 

utilized. 

Use Station Value Stored with Point - When selected, any station stored with the point is 

utilized in the list box and output. If the point has no stored station, a default station of 0+00 is 

listed. 

Compute Station Value from Chain - When selected, the point is projected onto the specified 

chain and the station is determined. Note this station is only used within the dialog and the 

station originally stored with the point is not changed. 

Chain to Measure Station and Offset From - Previously stored chain utilized to compute 

station and offset of points when the Compute Station Value from Chain option is utilized. 

Select Points to Export 

Points list box - The list box is populated by either a selection set or 

COGO navigator operation. Once the box is populated, the user must 

highlight the desired points for exportation. 

Select All Points - Utilized after the list box is populated, pressing this icon highlights all 

entries in the list. 

Clear All Points – Utilized after the list box is populated, pressing this icon unhighlights 

all entries in the list. 

Get Points from Navigator – Once a MicroStation selection set has been defined, 

pressing this icon utilizes the selected COGO visualized elements to populate the list box. 

Get Points from MicroStation Selection Set – Once the desired elements have been 

highlighted in the COGO navigator, pressing this icon populates the list box. 
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Output Format 

Prefix – Syntax which is placed before the actual Text for each data 

item. Note: may be blank. In addition, to space between the prefix 

and the text, place blanks in the prefix field. 

Text – The data options: Point, North, East, Elev, Feature, Station, 

Desc or None. When each Text option is set, the data is placed in the 

specified order, with associated Prefix and Suffix, into the output file. 

For example, if the desired output file contains only the point, X and 

Y coordinates and is comma delimited, the Output Format group box would resemble the 

illustration below. 

Suffix – Syntax that is placed after the actual Text for each data item. Note: may be blank or 

used as a delimiter. The key words ENT and TAB are supported within the suffix field. The TAB 

utilizes a tab in the output file, while the ENT utilizes a CR/LF (carriage control / line feed.) 

Alignments and Profiles 

TDS Format 

 

Chain and Profile fields may be keyed in. In lieu of typing, selection of the Chain (or Profile) 

button invokes a selection dialog, wherein the desired element may be selected. An Output File 

completes the required information, and clicking Apply commences the procedure. 

SMI Const V Format 
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1.4.2 Edit Commands 

 
 

Clear - empties the memory of the current input and output buffers without saving and initializes 

the line numbers to begin a new sequence of commands. 

 

Delete - deletes input commands in the input buffer by line number (or range of line numbers) 

and re-sequences the line numbers for the remaining commands. 

 

Insert - allows the user to add a command line to the current input buffer before a specified line 

number; the other command lines will shift down and line numbering will automatically be re-

sequenced 

 

Modify - allows the user to change a word in a command line. The modified command line will 

not be computed until the operator uses the Read command. 

 

Read All - the lines in the output buffer are processed. This may be done for the entire file (All) 

or by specifying a range of line numbers (Line Range). 

 

Type All - displays the content of the current input file. 

 

Line Range - displays a portion of the file by specifying a range of line numbers. 

 

Editor - opens the GEOPAK COGO Command Editor, which allows the user to edit an input 

file before executing. 
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1.4.3 Element Commands 

1.4.3.1 ELEMENT>>POINT 

 
 

Utility - The Point Utility tool displays a list of all stored points, and 

has options for deleting, printing, or visualizing points.  

 

Delete – deletes one point or multiple points currently stored 

in the .gpk file.  User must highlight the points to be deleted in 

the utility tool display list, then click on the delete icon. 

 

Print - prints point data currently stored in the .gpk file 

including coordinates and other associated data. 

 

Visualize– visualizes currently stored points in the .gpk file 

according to the visualization settings in the coordinate 

geometry dialog.  If visualization is turned off, points will not be visualized. 

 

Cell - assigns a cell name to a previously stored point 

 

Copy – copies points or a point range to a new point 

number or range within the same Geopak database 

 

Elevation - assigns an elevation to a previously 

stored point 

 

Equate - stores a new point with the same values as 

a previously defined point 

 

Station - allows you to specify a station for an 

existing point. 

 

Store - stores a point located by key-in or by 

digitizing a point on the screen. A station, elevation, 

point code, cell, feature, or description can be added 

to the point.  
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Transformation - transform one set of points into a new coordinate system. 

 

Compare Points to TIN – computes the elevations of a given set of points based on a given 

DTM, and outputs the elevations to a text file. 

 

Set Elevation From Tin – computes the elevations of a given set of points based on a given 

DTM, and stores the elevations to the points. 

1.4.3.2 ELEMENT>>LINE 

 
 

Utility - displays all stored lines, and has options for transposing, 

deleting, printing, or visualizing lines. 

 

Transpose – Changes the direction of the selected lines. 

 

Delete – Removes the selected lines from the GPK. 

 

Print – Writes information about the selected lines to the 

COGO output window. 

Visualize - Plots lines based on current COGO visualization 

settings. 

Store - stores a line based on one point and a direction or two 

points.  The line name can be alpha-numeric (but not numeric-

alpha) to a maximum of nine characters. 

 

 

 

 



Chapter 1 - Coordinate Geometry GEOPAK Road 

1-18 Missouri Department of Transportation 9/21/12 

1.4.3.3 ELEMENT>>CURVE 

 
Utility - displays all stored lines in .gpk file, and has options for transposing, deleting, printing, 

or visualizing lines. 

 

Copy - copy a specified curve to another curve name 

 

Data - calculates the geometric parameters of a curve, displaying 

values for Delta, Degree, Tangent, Length and Radius 

 

Segment – defines new curves by dividing a stored curve into 

segments. 

 

Station - allows the user to identify a curve and the position on the curve (PC, PI, or PT) that a 

station value may be assigned. 

 

Store - provides various options for defining and storing lines 

and curves such as By Tangents, By End Points (from PC 

and PT previously stored) or Concentric as shown to the 

right.  

 

 

 

 

 

Storing a curve By Tangents is the 

most commonly used tool to store 

curves.  
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1.4.3.4 ELEMENT>>SPIRAL 

 
 

Utility - displays all stored spirals in the .gpk file, and has options 

for deleting, printing, or visualizing spirals. 

Copy - copy a specified spiral to another spiral name 

 

Store - provides various options for defining and storing spirals. 
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1.4.3.5 ELEMENT>>CHAIN 

 
 

 

Utility - displays all stored chains in the .gpk file, and has options for 

computing area, deleting, printing, describing, or visualizing chains. 

 

Area – calculates the area of a closed chain previously stored in 

the .gpk file. 

 

Delete – deletes chains stored in the .gpk file. 

 

Print – displays the name of each chain element. 

   
Describe – displays the alignment data of each element in the 

selected chain. 

 

Visualize - plots chains based on current COGO visualization settings.  

 

Layout Offset – computes the station and offset of a point or a chain based on a given chain. 

 

Station - provides a method for 

stationing or re-stationing a 

chain. 

 

Station Equation - provides a 

method for applying a station 

equation to a chain 

 

Store - provides three options 

for storing a chain in the 

database, From Elements, 

From Offset Chain, and 

Transition Chain.  
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1.4.3.6 ELEMENT>>PARCEL 

 

Utility - displays all stored parcels in .gpk file, and has options for describing, deleting, printing, 

or visualizing parcels. 

Copy - This command copies a specified parcel to another parcel name. 

Store - allows a user to store a parcel by adding points, curves and spirals. 

 

Subdivide – divides a parcel into individual lots. 

 

Editor – edits a parcel 

Default Attribute Preferences - The Default Attribute Preferences are assigned to each 

subsequent parcel that is stored.   Attributes can have either numeric value or text string.  
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Manual Entry - Parcel Commands 

 
Store Taken - allows you to store the portion of a parcel taken by entering point and curve 

names in either a clockwise or counterclockwise direction. 

 

Store Easement - allows you to store an easement by entering point and curve names in either a 

clockwise or counterclockwise direction. 

 

Own Parcel - stores the name of the owner associated with a previously stored parcel.  

 

Make Legal - creates a legal description and writes it to a user named text file. 

 

For more detailed parcel information, the Geopak Help Manual. 
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1.4.3.7 ELEMENTS>>PROFILES 

 
 

Utility - displays all stored profiles in .gpk file, and has options 

for deleting or printing profiles. 

Elevation - provides three options for reporting elevations along 

a selected profile, Station, Even Station, Incremental Stations 

 

Offset – stores a new profile at a given vertical offset. 

 

Restation - creates a Target Profile based on a Source Profile 

and Chain, but uses the Begin Station specified in the dialog. 

 

1.4.4 View Commands 

 
 

Icons – allows the user to customize which icons appear in the tool bar. 

 

Redefine – shows the Redefine box on the tool bar. 

 

Visualization – shows the visualization items on the tool bar. Format – shows the format items 

(i.e. number of decimals, station format, etc.) on the tool bar. 

COGO Key-in – shows the COGO Key-in box for entering commands in the dialog. 
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Command Output - show the Command Output Window in the dialog box, and controls 

options for the Command Output Window. 

 

Error Alert – allows the user to turn on a beep and/or bring up the COGO dialog when an error 

occurs.   

 

1.4.5 Tools Commands 

 
 

 

Navigator – starts the COGO Navigator.  (This will be covered in more detail in Section 5.5 of 

this chapter) 

 

Inverse – calculates the distance and direction between points and multiple points.   

 

 

1.4.6 Locate tools 

Locate Commands enable the user to locate 

and store point(s) by reading and processing 

from previously stored points, geometry and/or 

stationing. 

 

 

 

 

 

 

 

 

LOCATE TRAVERSE TOOL – locates a point from another point by several methods such as 

distance and direction, or station and offset.  (To locate by distance and bearing, use the Tools 

>> Locate >> Traverse) 
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Traverse commands locate and store a new point expressed as a direction and distance from a 

previously stored point. If an offset is specified, it is located at a radial offset distance from the 

line defined by the previously defined point and direction. 

 

 

Elevation On - When active, indicates a 3D traverse. In this case, the Elevation and Instru.  

Heights fields are unghosted. When inactive, 2D traverse is performed and the Elevation and 

Instru. Heights fields are ghosted. 

Side Shot Mode - When the Side Shot toggle is active, the Starting Point remains the same and 

only the Locate point increments. If the Side Shot toggle is not active, (indicating traverse 

mode), after each new point is located the Starting Point becomes the point just located. 

Locate Point - New point number to be located. 

Starting Point: Name - Initial point to be traverse from. 

 

Equate - Opens the Equate dialog, wherein the control point (PC, 

PT, etc.) and curve or spiral name are selected. Once the curve or 

spiral is highlighted and the Apply button is clicked, the dialog 

automatically closes, returns to the Traverse dialog and populates the 

dialog. 

 

 

 

Elevation - elevation of the initial point. Only active if the Elevation option is toggled on, 

indicating a 3D traverse. 

Height of Instrument - Height of instrument - utilized in 3D traverse. 
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Direction - These include Value, Bearing, Azimuth, and From pa To pb, the direction 

between two previously stored points. As the Direction options are selected, the dialog keyin 

fields reflect the various options. 

Offset Distance Right/Left - Optional field active when toggled. Specify the distance in terms 

of master units (i.e., feet or meters) and select Right or Left. The Signing Convention for 

offsets is: POSITIVE to the RIGHT of direction and NEGATIVE to the LEFT of direction ( "-" 

required ).  Even though an offset has been specified, it will not be utilized if the toggle is not 

activated.  

Distance - Horizontal distance in terms of master units (i.e., feet or meters) to be traversed. The 

Value option is specified in master units, i.e. feet or meters. Optionally, another value may be 

added or subtracted to the original value. The From pa To pb supports the distance between two 

previously stored points. Optionally, another value may be added or subtracted to the distance 

between the points. The Radius Curve option is also specified in master units, i.e. feet or 

meters. There is no option for adding or subtracting an additional value. 

 

Zenith Angle – Zenith angle. 

Rod Height – Rod height. 

 

Apply – Commences the traversing procedure. 

 

 

LOCATE BY ANGLE TOOL - The Locate By Angle 

commands locate and store a forward sight, expressed as an angle 

sweeping clockwise or counterclockwise from a line formed 

between a back sight, a station line and a length. The optional 

vertical angle in the command line is required when the forward 

sight point is in a horizontal plane which varies from that of the 

station point. 

 

Forward Sight Point - Key in the new point name. 

Auto Increment - If the toggle is activated, each click of Locate increases the Forward Sight 

Point number by one.  

Back Sight Point - Previously stored point. 

 

Station Point – Previously stored point. 

 

Angle – Must be in degree format. 

 

Length – Master units (i.e. feet or meters). 

Vertical Angle - Must be toggled on to be utilized and is required when the Forward Sight 

Point is in a horizontal plane, which varies from that of the Station Point. 

 

Locate – Commence locating. 
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INTERSECT TOOL– The Intersect commands enable the user to locate and store point(s) by 

reading and processing from previously stored points, curves, lines, spirals and chains, all from 

one dialog.  

 
 

At the top of the dialog is the new point number to be located. When the Auto Increment toggle 

is active, the point number increments by one each time the Intersect button is pressed. The rest 

of the dialog is split into two groups each defining one element of the intersection. As each 

element type is selected, the dialog dynamically changes to reflect the selection. For example, in 

the dialog above, when Line is selected, input requirements include Direction and Point. 

However, in the bottom of the dialog where the element is Chain, the input requirement is simply 

chain name. Supported intersection elements include: 

 

 Point to Point 

 Line 

 Arc 

 Spiral 

 Curve 

 Chain 

Point-to-Point - The line input requirements consist of two Point fields. The optional Offset can 

be utilized by toggling on the desired offset and typing in the Distance value, in terms of master 

units, i.e., feet or meters. Standard surveying convention is utilized for selection of Right and 

Left.    

 

Intersect Tool – Point-to-Point option 
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Line - The line input requirements consist of Point and Direction options. These include 

Bearing, Azimuth, QDD.MMSS, pa TO pb, and Direction Back, Direction Ahead and 

Direction of Chord for Curves and Spirals. Optional offsets can be utilized by toggling on the 

desired offset and typing in the Distance value, in terms of master units, i.e., feet or meters. 

Standard surveying convention is utilized for selection of Right and Left.  If the intended 

directions do not create an intersection, one or both lines are extended to make an intersection. A 

warning message is printed to indicate extended lines.  

 
 

 

Arc- The Arc group box consists of the Center Point and Radius keyin fields, but no offsets. 

The Center Point number must be a previously defined point and the Radius is specified in 

terms of master units. Note that arc-chain and arc-curve intersections are not supported.  

 

 

Spiral - The Spiral group box consists of the Spiral Name key-in combo field and optional 

Offset. The Spiral Name can be selected from the list of stored curves or typed into the field. 

The toggle to the left of the Distance activates the optional Offset. Specify the desired Offset (in 

master units), then select the Right or Left option. 

 
 

 

Intersect Tool – Line option 

Intersect Tool – Arc option 

Intersect Tool – Spiral option 
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Curve - The Curve group box consists of the Curve Name key-in combo field and optional 

Offset. The Curve Name can be selected from the list of stored curves or typed into the field. 

The optional Offset is activated by the toggle to the left of the Distance.. Specify the desired 

Offset (in master units), then select the Right or Left option. 

 
 

 

Chain - The Chain group box consists of the Chain key-in combo field and optional Offset. The 

Chain can be selected from the list of stored curves or typed into the field. The toggle to the left 

of the Distance activates the optional Offset. Specify the desired Offset (in master units), then 

select the Right or Left option. 

 
 

 

 

Three directional qualifiers (Back, Ahead, and Near Point) are supported in intersection options 

where multiple solutions are possible. The qualifiers signal to the software which intersection is 

desired when there are two solutions. When the dialog is completed, clicking Intersect 

commences the computation. 

 

 

BEST FIT TOOL – calculates a best-fit chain through a set of points. 

 

TRANSLATION AND ROTATION TOOL – moves, rotates, and scales a data set. 

 

MAP CHECK TOOL – edits a parcel. 

 

ROADWAY INTERSECTION TOOL – calculates the data for the intersection of two 

roadways. 

 

CUL-DE-SACS TOOL – calculates the data for a cul-de-sac. 

 

 

Intersect Tool – Curve option 

Intersect Tool – Chain option 
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REDRAW VISUALIZED ELEMENTS – re-syncs the coordinate geometry data with the data 

displayed in the Microstation file. 

 

CLEAR VISUALIZED ELEMENTS (TEMPORARY) – clears the temporary visualized 

elements from the view. 

 

CLEAR VISUALIZED ELEMENTS (ALL) – clears the visualized elements from the 

Microstation file. 

 

1.4.7 View pulldown 

 

 

 

 

 

 

 

 

 
 

Icons - COGO command dialogs (i.e., store point, describe chain, etc.) can be invoked from 

icons, in addition to the pulldown options. Quite often, depending on the task, the user utilizes 

the same commands repetitively. Rather than continually selecting the pulldown, the icon for 

each dialog can be displayed. Pressing the icon invokes the same dialog as the pulldown. The 

user selects which icon or group of icons is displayed from the View Icon tools, described in the 

table below. 

 

Detach This Group – Allows the user to remove a 

tool bar from the Coordinate Geometry dialog box. 

 

Customize This Group - Selection of this pulldown 

invokes the Customize Icons dialog, wherein group or 

individual icons may be activated or deactivated. 
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Redefine - This option is a display / non-display option, rather than several 

settings. When activated on the View > Redefine, the Redefine option is 

displayed at the top of the dialog, for easy activation / deactivation at any 

time during a COGO session. When this toggle is not active, any attempt to 

overwrite previously stored data will not be processed and a "Data Already 

Exists" message is displayed. If the toggle is active, the data is overwritten 

and a "Data Redefined" message is displayed. 

 

1.5 COGO Navigator 

COGO Navigator is a tool to easily view and edit COGO data.  Navigator can be accessed by 

the pull down menu COGO >> Tools >> Navigator or by the Navigator icon.   

 

 
 

 
 

From the Navigator, points, lines, curves, spirals, chains, survey chains, parcels, and profiles can 

be added, deleted, modified, identified, visualized, printed, or selected. 
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1.5.1.1 NAVIGATOR>>SELECT MENU 

An alternate method of highlighting elements within the Navigator Name / Feature list box is the 

use of three Selection tools, located on the Select menu in the upper left corner of the Navigator. 

 

Select All – Highlights all elements within 

the Name / Feature list box regardless of 

their current status.  

Invert Selection – Reverses the 

highlighting. 

Clear Selection – Removes highlighting 

from those elements in the Name / Feature 

list that were previously highlighted. 

 

Selection Set - allows the user to create a selection set that meets particular criteria.  

This is the same as using the Selection Set icon.  

 

 

Three additional tools on the Select pulldown enable the user to manipulate the screen or Name / 

Feature list box. 

Fit View (Selection Set) – First, highlight the desired elements in the Name / Feature list box. 

When this tool is selected, the screen is fitted to display only the selected elements.  

Show Selected Elements Only - First, highlight the desired elements in the Name / Feature list 

box. When this tool is selected, all elements not highlighted are temporarily removed from the 

Name / Feature list box. The subset of displayed elements can be utilized for other Navigator 

commands until the Navigator is closed or a Show All Elements command is issued. 

Show All Elements - When this tool is selected, all elements of the specified element type are 

displayed in the Name / Feature list box. This command is utilized to countermand the Show 

Selected Elements Only command. 

The last tool on the Select menu is Selection Set, used to create the selection set for use with 

other Select tools. 
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1.5.1.2 NAVIGATOR>>TOOLS 

 

Add Element – allows the selected type of 

element to be stored. 

 

Delete Element – deletes the selected type of 

element.  

 

Edit Element – allows the selected element 

to be edited. 

 

Identify Element – allows the user to select 

an element by selecting it graphically. 

 

Print/Describe Element – Displays the 

selected element’s coordinate or alignment 

data. 

 

Edit Element Feature – Changes the feature code 

of the element. 

 

Visualize Element – Displays the selected elements according to their feature codes. 

 

Unvisualize Element – When selected, the visualization of the highlighted elements is deleted. 

Note the element is not deleted from the database, just its visualization. 

Visualize All – If the user wants all points (or all curves, parcels, etc.) visualize, the entire name 

/ Feature list box can be highlighted and the Visualize Element tool can be utilized. However, for 

ease of use, utilizing the Visualize All options do not require highlighting any elements within 

the Name / Feature list box. Simply select the Visualize All and desired element from the option 

pulldown. 

 
 

Redraw Visualized Elements - When selected, all visualized elements are redrawn. If the 

location of an element in the design file does not correspond to its coordinates in the database, 

the element is redrawn utilizing the database information. If a visualized element was deleted 

using generic MicroStation commands, the COGO element is redrawn. 
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Clear Visualized Elements (Temporary) – When selected, all temporary visualized elements 

are deleted. Note the elements are not deleted from the database. 

Clear Visualized Elements (All) – When selected all temporary and permanent visualized 

elements are deleted. Note, the elements are not deleted from the database. 

 

 

 

1.5.1.3 NAVIGATOR TOOL SETTINGS 

 

Settings – Several tool settings are supported for user 

flexibility. The settings dialog is separated into four 

sections: 

  

 

 

 

 

 

 

 

 

Selection Set 

Alert Prior to Clearing Selection Set - When activated and the user selects the a command 

which requires a new selection set, an Alert message is displayed. 

Clicking Yes clears the current selection set and the selected command / dialog is processed. If 

No is clicked, the current selection set is not cleared and the selected command request is 

ignored. 

Single Click Action 

 

Two options are supported, which may be selected simultaneously. 

Highlight Visualized Element - If the Highlight Visualized Element is active, a single click on 

any element within the Name / Feature list box highlights the element. Note either temporary or 

permanent visualization must be active.  

Window Center Visualized Element - When the Window Center option is active, a single 

click on any element in the Name / Feature list box window centers the element. If both toggles 

are active, the element is centered and highlighted. 



GEOPAK Road Chapter 1 - Coordinate Geometry 

9/21/12 Missouri Department of Transportation 1-35 

Mouse Click Action 

Double Click Action - As a shortcut to many of the 

frequently used element commands, this option enables the 

user to select one of the commands listed to the left. When 

an element in the Name / Feature list box is double clicked, 

the selected command in the tool settings is invoked. For 

example, if the Print Element command is selected in the 

tool settings, then when any element in the Name / Feature 

list box is double clicked, the print element command is invoked. If the Visualize Element 

command is selected in the tool settings, when any element in the Name / Feature list box is 

double clicked, the element is visualized. If the Do Nothing option is selected, a double click on 

any element invokes no command. 

Note the difference between a double click action and a second click action is simply timing. 

Two clicks extremely close together is considered a double click, while a single followed closely 

by a second is considered a second click.  

Second Click Enables List Cell Editing - When this toggle is active the various fields in the 

Navigator list box may be edited.  When toggled off, no editing within the Navigator list box  is 

supported. 

 

Note the difference between a double click action and a second click action is simply timing. Two 

clicks extremely close together are considered double clicks, while a single followed closely by a 

second is considered a second click. 

Display Options - If the current GPK file has both Survey points (processed through the Import 

to Database procedure in the Survey Project Manager) and COGO points, stored via COGO 

commands, the View options support viewing all points (both survey and COGO), COGO only, 

or Survey Only. 
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All Points, COGO Points Only and Survey Points Only - If the current GPK file has both 

Survey points (processed through the Import to Database procedure in the Survey Project 

Manager) and COGO points, stored via COGO commands, the View options support viewing all 

points (both survey and COGO), COGO only, or Survey Only. 

1.5.1.4 MERGING GPK ELEMENTS 

A Visual Basic Application (VBA) is available to allow users to merge elements from one GPK 

to another.  This VBA is located under the MicroStation Add-Ons pull down menu.   

Add-Ons>>Geopak Utilities>>Merge GPK Elements – Geopak must be running.   

 

 
 

When opening the tool, the user will get the following dialog box.  Select OK to dismiss. 

 

 
 

The tool requires a source and a target GPK.  Both databases must exist before running the tool.  

The source GPK is defined as the database from which the elements are extracted, and the target 

one is where the elements will be transferred. 

 

The user can select multiple type geometry at one time.  To select an element, first select the type 

of geometry and then high light from the available list.  The tool offers two options for handling 

existing geometry in the target GPK with the same name.  One is to always “Ask Before 

Redefining Elements”, and the second one is to “Always Redefine Elements”.  If any 

redefinition of elements must be done, the Redefine toggle must be checked on in the Coordinate 

Geometry dialog box. 

 

Once the tool is set up, select Merge Elements.  

Once the tool is done merging elements, the 

user will get the message to the right. To view 

the log file select Yes. 
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1.6 Individual Exercise 1: Route 24 

 

1. Open the following MicroStation file: 

 

District CADD\Design\Randolph\J2P0200\data\Cogo_Practice.dgn. 

 

 

2. Go to Applications>>GEOPAK Road>>User Preferences and verify the following 

settings: 

 

 
 

Then select COGO Preferences and verify the Job (GPK), Directory. 

 

  
 

Job Directory = t:\de-proj\Randolph\J2P0200\data\ 
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3. Open the Coordinate Geometry dialog.  

 

Create Job Number: 011 

 

Set the Operator Code to your initials. 

 

  
 

 

4.  Since this coordinate geometry database does not exist, you will get the following 

message.  Select Yes to the alert dialog to continue. 

 

  
 

 

 

 

 

 

 

 

 

Create the following alignment as shown on the following pages. 
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Chapter 1 - Coordinate Geometry GEOPAK Road 

1-40 Missouri Department of Transportation 9/21/12 

 

5. Store points 501 and 505 with the coordinates shown. 

 

   
 

6. Locate points 502 and 504. 
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7. Locate point 503 by using the Intersect tool. 

 

 
 

 

8.  Store CURVE1, CURVE2, and CURVE3. 
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7. (Continued) 

 
 

m = minus, p = plus 

 

 
 

9. Store the alignment chain Route24. 
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10. Station the centerline at the beginning with station 10+12.6 

 

 

 

 

 

 

 

 

 

 

11. Describe and review chain information in the COGO output window.   Next save an 

output file.  Review the output file in any Text Editor (UltraEdit, Notepad, etc.). 

 

12. Use COGO Navigator to view the data. 

 

13. Upon completion of storing the alignments in coordinate geometry, close coordinate 

geometry.  

 

14. Delete all of the graphics in the MicroStation drawing by going to Edit > Select All, and 

then selecting the Delete button. 
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1.7 Individual Exercise 2: Route63 and Road 1 Alignments 

This is an individual exercise to practice storing horizontal alignments. 

 

Open the MicroStation file  

District CADD\Design\Randolph\J2P0200\data\Cogo_Practice.dgn. 

 

Continue using GPK 100, as shown in the following dialog 

 

 

 

 

 

 

 

 

 

 

 

Use Coordinate Geometry to create the alignments as shown on the following pages. 

 

Do not worry about the graphics (stationing, curve data, etc.) being plotted.  These items will 

be discussed in later chapters. 
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Route 63 
 

Beginning Point: X = 1676434.4103 Y = 1262365.4715 

 

Ending Point: X = 1678994.1614 Y = 1257205.0288 

 

Intersect the PI point using the direction back and direction ahead of the spiral-curve-spiral. 

 

Store the spiral-curve-spiral RTE63-1 

 Direction Back  = S 0° 20’ 19.8” E 

 Length of the back spiral  = 200’ 

 Degree of Curve  = 2° 30’ 00” 

 Length of the ahead spiral  = 200’ 

 Direction Ahead  = S 45° 39’ 27.2” E 

 

Store the alignment as RTE63 with a beginning station of 9+50.00. 

 

 

Road1 
 

Beginning Point: X = 1676792.0050 Y = 1260393.1372 

 

Ending Point: X = 1679002.6087 Y = 1257759.8897 

 

Intersect the PI point using the direction back and direction ahead of the curve. 

 

Store the curve ROAD1-1 

 Direction Back  = S 24° 20’ 00.0” E 

 Degree of Curve  = 1° 45’ 00” 

 Direction Ahead  = S 52° 30’ 00.0” E 

 

Store the alignment as ROAD1 with a beginning station of 0+00.00. 

 

 

Make sure there are no kinks in the alignments and that you have meet the above design 

parameters. 
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1.8 Individual Exercise 3 (Optional): B1 

1. Create a new MicroStation file named B1.dgn 

 

2. Open the Coordinate Geometry dialog.  

 

Create Job Number: 456 

 

Set the Operator Code to your initials. 

 

 

 

3. Use the Coordinate Geometry tools to create chain B1 as shown below.  Verify the 

area of the chain. 

 

Hints: 

 

Angles at 604 and 605 are not 90 

 

Store point 604 and the curve before 

storing points 607 and 608 
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1.9 Group Exercise 1: Working Alignment & Plotting Plan Graphics 

This exercise uses D & C Manager to plot the plan view elements for Route 63 (Chain RTE63) 

and the outer road (Chain ROAD1).   
 

1. Open the MicroStation file: 

  

District CADD\Design\Randolph\J2P0200\data\plan.dgn. 

 

2. Switch gpk files through the project manager.   

 

Project path:  District CADD\Design\Randolph\j2p0200\project 

 

Project file: J2P0200.prj  
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3.  From the Project Info Edit dialog define the following: 

 

Working Alignment: pw:\District CADD\Design\Randolph#\J2P0200\data 

Job Number: 200 

Project Description: Job 200 = Class GPK 

 

 
 

Select the OK button 

 

 

4. Select ClsUser  
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5. Since chains have now been defined for the two alignments, create a working alignment for 

each chain by copying the MoDOT Working Alignment.  To do this click on the Select 

button in the Road Project dialog.  . 
 

 
 

Copy the MoDOT Working Alignment Run and call the new run RTE63.   

       

Enter the RTE63 working alignment. 

      

Select the Define button to set up the Working Alignment Definition for the Plan View Section 

as shown in the next dialog box.   

 

  
   

Click OK to save the changes to the alignment definition. 
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6. Set up the working alignment definition for the ROAD1 corridor. 

 

Copy the MoDOT working alignment and name the new run ROAD1. Enter the new run.  

 

Select the Define button to set up the Working Alignment Definition for the Plan View Section 

as shown in the next dialog box.  
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7. To draw the two alignments with their stationing, select D&C Manager 

       

      Select the item English/Drafting Standards/Plan/Alignments/MoDOT Proposed Baseline 

       

 
8. Select the Draw Plan & Profile Button 
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9. Select the Chains Operation.  
 

Set the Label Scale to 50 

Check that the following items are checked: 

 Line Direction 

 Curve Label 

 Curve Data 

 Spiral Label 

 Spiral Data 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the Chains RTE 63 and ROAD1.  (One click for each chain only) 
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10. Switch the Operation to Stationing. 
 

Check that the following items are checked:  

 Tick Marks 

 Tick Mark Stations 

 PC & PT & CS … Labels 

 PI Labels 
 

 

Set the following options: 

 Small Ticks: Ticks LT, Labels LT 

 Large Ticks: Ticks Both, Labels LT 

 Control Point Labels: As Per Preferences 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the Chains RTE 63 and ROAD1. 
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11. Based on the typical section for Route 63 (see the separate handout), there are three possible 

locations for the edge pavement line next to the median.  Because the shoulder next to the 

median is an A1 shoulder with no joint between the pavement and shoulder, one option is to 

place the edge of pavement line at the median edge of shoulder (offsets -26’ & 26’).  The 

second option is to place the pavement edge 2’ into the shoulder (offsets -28’ & 28’).  The 

last option, which is the one used for this exercise is to place the edge of pavement at the 

edge of the driving line (offsets -30’ & 30’).  This taken into consideration, the offsets for the 

edge of pavement are –56 (-26-30), -30, 30, and 56.   

       

Use the Draw Transition tool to create the EOP for chain RTE63 with the following item. 

 

Use the Design and Computation Manager item: 

 

Design Standards\Roadway\EOP New – Edge of Pavement (New). 
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12. Don’t worry about setting up any AdHoc Attributes for any plan view elements; Roadway 

Designer does not use this functionality. 

 

 
 

 

13. Be sure when placing lines that Place Influence is turned on. 

 

 
 

     Select the Draw Transition Tool 

 

 

 

 

 

     Draw the EOP using the parameters shown below. 

 

 Beginning Station Beginning Offset Ending Station Ending Offset 

 Start of Chain -56 End of Chain -56 

 Start of Chain -30 End of Chain -30 

 Start of Chain 30 End of Chain 30 

 Start of Chain 56 End of Chain 56 
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14. Use the Draw Transition tool to create the edges of outside shoulder for Route 63 with the 

following parameters.  From the typical section there is no separated paved shoulder on the 

median side; therefore, the offsets are –64 (-56-8), -26, 26 and 64. 
 

Use the following Design and Computation Manager item:  
 

Design Standards\Roadway\EOS New Conc. – Edge of Shoulder - Concrete (New). 
 

 
 

 

 

Be sure that Place Influence is turned on. 
 

 

 

 
 

Use the following settings in the Draw Transition Tool: 
 

Beginning Station Beginning Offset Ending Station Ending Offset 

 Start of Chain -64 End of Chain -64 

 Start of Chain -26 End of Chain -26 

 Start of Chain 26 End of Chain 26 

 Start of Chain 64 End of Chain 64 

 

Save the changes to the DGN file. 
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15. Based on the typical section for the outer road (see the separate handout), the offsets for the 

edge of pavement are –12 and 12.  Use the Draw Transition tool to create the edges of 

pavement for ROAD1 with the following parameters. 

 

Use the Design and Computation Manager item:  

 

Design Standards\Roadway\EOP New – Edge of Pavement (New). 
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18. Continued - Be sure that at least the Place Influence is turned on.  The New Element Only 

toggle is optional. 

 

 
 

 

Use the following settings in the Draw Transition Tool: 

 

Beginning Station Beginning Offset Ending Station Ending Offset 

 Start of Chain -12 End of Chain -12 

 Start of Chain 12 End of Chain 12 
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16. Use the Draw Transition tool to create the edges of shoulder for ROAD1 with the following 

parameters. 

 

Use the Design and Computation Manager item:  

Design Standards\Roadway\EOS New Aggr. – Edge of Shoulder – Aggregate (New). 

 

 
 

Be sure that Place Influence is turned on. 

 

 
 

 From the typical section, shoulder exists only from Sta. 25+30.00 to the End of the Project.  

Use the following settings in the Draw Transition Tool: 

 

Beginning Station Beginning Offset Ending Station Ending Offset 

 25+30.00 -18 End of Chain -18 

 25+30.00 18 End of Chain 18 
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17. Use the Draw Transition tool to draw the curb for ROAD1 with the following parameters. 
 

Use the Design and Computation Manager item:  

Payitems\Roadway\Curb\609-10.52 Curb And Gutter Type B 
 

 
 

Be sure that Place Influence is turned on. 

 

 
 

Use the following settings in the Draw Transition Tool: 
 

Beginning Station Beginning Offset Ending Station Ending Offset 

 Start of Chain -15 25+30 -15 

 Start of Chain 15 25+30 15 
 

Save the changes to the DGN file. 
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18. There is a sidewalk on the left side of the outer road from Sta. 0+00 to Sta. 25+30.  The 

inside edge of sidewalk is at the back of the curb.  The outside edge has an offset of 20’ (12 + 

3+5).  Use the Draw Transition tool to create the outside edge of sidewalk for ROAD1 with 

the following parameters. 

 

Use the Design and Computation Manager item:  

Design Standards\Roadside\Sidewalk (New). 

 

 
 

Be sure that Place Influence is turned on. 

 

 
 

Use the following settings in the Draw Transition Tool: 

 

 Beginning Station Beginning Offset Ending Station  Ending Offset 

 Start of Chain   -20   25+30   -20 

 

This completes the lines needed to show the roadway in the plan sheets for Route 63 and Road1.   

 


